Sistemas Embebidos para Tiempo Real

Laboratorio 1 - Introduccion al entorno de desarrollo CCS

Introduccion

En este laboratorio se daran los primeros pasos de utilizaciéon del entorno de desarrollo integrado (IDE,
Integrated Development Environment) Code Composer Studio (CCS) para la creacién de aplicaciones
embebidas y se introducira la plataforma de hardware Launchpad MSP-EXP430G2 o MSP-EXP430G2ET con
un microcontrolador MSP430G2553 a utilizar durante los laboratorios, desarrollando parcialmente un médulo de
reloj de tiempo real.

En muchas aplicaciones donde es necesario manejar la nocién del tiempo se utiliza un reloj de tiempo real para
el monitoreo, disparo o etiquetado de eventos. Para el seguimiento del tiempo tipicamente se utilizan dos
métodos: contar los milisegundos transcurridos a partir de cierto instante de tiempo o directamente contar
milisegundos, segundos, minutos y horas. Si ademas interesa la nocion del tiempo al pasar de los dias o a lo
largo del afio, se lleva la cuenta de los dias, dia del mes, mes, etc. Ambos métodos presentan ventajas y
desventajas. En este laboratorio se desarrollara una primera parte de un médulo de reloj (que se llamara
“timer”) utilizando el segundo método. En el laboratorio 2 se continuara el médulo utilizando un temporizador
hardware.

Este laboratorio también servird como una introduccién a GIT y a las buenas practicas de programacion.

Objetivos

Objetivos generales

* Emplear las herramientas del entorno de desarrollo CCS para compilar, ejecutar y depurar programas
en plataformas de hardware.

e Emplear una herramienta de control de versiones.
*  Emplear una herramienta para documentacion automatica de codigo.

* Repasary aplicar conceptos basicos de programacion en lenguaje C orientados a sistemas embebidos.

Objetivos particulares

1. Crear un proyecto en CCS y configurar sus opciones basicas. Escribir y agregar archivos fuente al
proyecto.

2. Compilar y enlazar la aplicacion. Interpretar los archivos generados.

3. Depurar la aplicacion ejecutando en hardware, utilizando el Launchpad MSP-EXP430G2 o MSP-
EXP430G2ET.

4. Observar la dependencia entre algunas decisiones en el cédigo fuente y el programa generado por el
compilador/linker.

5. Mantener un repositorio con diferentes versiones de una aplicacion utilizando GIT.

6. Repasar y aplicar conceptos basicos de programacion en C: visibilidad, alcance, tiempo de vida y
almacenamiento de variables, cualificadores, tipos de datos, y modularizacion (interfaz publica/privada,
utilizar funciones de acceso a variable, funciones privadas a un médulo, utilizaciéon de guarda).

Materiales

» PC con los siguientes programas instalados
» CCS v8.3 o superior
* Git y herramientas asociadas (por ejemplo Fork, Gitkraken o similar)
* Paquetes opcionales:
* En Windows: minGW, o una herramienta de su preferencia que le permita compilar con GCC
* En Linux: paquetes meld, gcc, tig
* Repositorio grupal de los Laboratorios, segun se describe en el documento “Guia de instalacion y




puesta a punto de herramientas para el Laboratorio de Sistemas Embebidos”
» Plataforma de desarrollo Launchpad MSP-EXP430G2 o MSP-EXP430G2ET con un microcontrolador
MSP430G2553.

Actividades a realizar

Parte 1) Instalacion de entorno de desarrollo y estudio del hardware
1. Lectura obligatoria de:
a) Guia de instalacién y puesta a punto de herramientas (disponible en el EVA del curso).
b) MSP430G2553 LaunchPad™ Development Kit (MSP-EXP430G2ET) User's Guide [1].

c) Slides del tedrico “Introduccion y conceptos basicos”, “Introduccion al lenguaje C”, “Herramientas de
desarrollo de software embebido”, y “Git: introduccién al control de versiones”.

2. Creacion del repositorio de Laboratorios (segun la guia antes mencionada)

Parte 2) Destello de un LED (Blink LED)

El programa que se presenta en la Figura 1 tiene el propésito de hacer conmutar una salida digital a cierta
frecuencia para hacer destellar un LED.

#include <msp430.h>
#define LED1 (0x0001)

int main (void)
{

volatile unsigned int i;

WDTCTL = WDTPW + WDTHOLD; // Detiene el watchdog timer
P1DIR |= LED1; // Configura pin LED1 salida
while (1)
{

P1OUT "= LEDI1; // Conmuta LED1 usando XOR

for (1i=10000; i>0; i--); // Retardo software

Figura 1

1. Crear un proyecto nuevo vacio de nombre labl-blink segun se explica al final del documento “Guia
de instalaciéon Code Composer Studio v8” pero en la carpeta test/blink.

2. Crear un nuevo archivo fuente en el proyecto (main.c),y copiar el cédigo anterior."

3. ldentificar las carpetas y los archivos creados para el proyecto (carpeta donde CCS ubica los proyectos)
con un administrador o navegador de archivos y en el propio CCS antes de compilar.

4. Compilar el proyecto e identificar los archivos creados (Menu: Project > Build Project).

5. \Verificar el correcto funcionamiento de la aplicacién iniciando la depuracion o debug (Menu: Run >
Debug) y luego seleccionar ejecutar (Menu: Run > Resume).

6. Para finalizar crear un tag en el repositorio de proyectos de nombre labl-blink.

Parte 3) Modulo Timer

Se pide Implementar el cédigo del médulo timer (timer.h y timer.c) descripto a continuacion, prestando
especial atencion a las técnicas de modularizacion.

El médulo de manejo del tiempo lleva la cuenta de las horas del dia, minutos, segundos y milisegundos. El
tiempo sera incrementado usando un periférico del microcontrolador que implementa un temporizador de
hardware (timer), aunque en esta version no sera implementado. En préximos laboratorios, la funcion que
incrementa el tiempo sera llamada desde la rutina de servicio a la interrupcion del timer. En esta instancia para
su evaluacion se llamara desde el main.

1 Si el proyecto se credé como “empty project with main” modificar el cédigo de main.c provisto.


https://eva.fing.edu.uy/mod/resource/view.php?id=86155

Requerimientos:

1. La interfaz publica incluye funciones para:
a) inicializar el reloj en un cierto tiempo
b) incrementar el tiempo en 250 ms
c) devolver el tiempo actual
Observacion: para determinar la firma de las funciones ver el uso del modulo en la Figura 2.

2. Para representar el tiempo definir un nuevo tipo utilizando una estructura para guardar: horas, minutos,
segundos, milisegundos. La variable donde se guarda el tiempo actual no sera accesible fuera del
maodulo.

3. Las funciones auxiliares, si las hubiera, deberan ser privadas al modulo.

El cédigo fuente puede ser compilado usando el IDE CCS o GCC.

Se debera tener previsto la posibilidad de mostrar el repositorio del grupo con la estructura de directorios
conteniendo el codigo pedido. Para identificar este punto en la historia del repositorio crear un tag de nombre
labl-parte3. Verificar que los cambios son visibles para todos los miembros del proyecto.

Se disenara y realizara una demo de validacion del timer compilando una aplicacién de prueba similar al cédigo
provisto en la Figura 2.

tiempo t t inicial = {23, 59, 59, 500};
tiempo t tl;
tiempo t t2;

int main (void)
{
tiempo t t local;

WDTCTL = WDTPW | WDTHOLD; // Detiene el watchdog timer

set time(t _inicial);
get time (&tl);

inc_time();
inc_time
inc_time

inc_time

)

).
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get time (&t2);
get time (&t local);

return O;

Figura 2

Compilacion (compiler/linker)

1. Crear un proyecto nuevo vacio de nombre lab1 en la carpeta test/lab1 creada previamente siguiendo la
guia.

2. Guardar los archivos timer.hy timer.c en los directorios /src e /include segun corresponda.

3. Copiar el fragmento de cédigo de la Figura 2 en un archivo de nombre main. c y modifiquelo de forma
de que incluya el header del modulo timer.

4. Compilar corrigiendo los eventuales errores.

5. Deducir a partir de la inclusion del archivo de encabezado <msp430.h> y siguiendo las dependencias
cémo se definen y mapean en memoria los registros del microcontrolador.

6. Inspeccionar el reporte del linker (archivo .map) identificando los diferentes segmentos y los objetos que
contienen (funciones, variables, etc.). Calcular el tamafio a ocupar por la Flash y la RAM.

7. \Verificar que los resultados anteriores concuerdan con los obtenidos por Memory Allocation (Menu: View
> Memory Allocation)

Depurado (debugging)

1. Iniciar el depurador o debugger.
2. Correr paso a paso utilizando todas formas posibles (Step Over, Step Into, Run-to, etc.) y deduzca la
utilidad de cada una (Menu: Run > ...).



5.

Asociar el cédigo en C con el cédigo assembler generado (Menu: View > Disassembly).

Experimentar utilizando diferentes vistas para inspeccionar (Menu: View):

o Variables (locales)

o Expressions (locales, globales, estaticas, expresiones validas de C, registros)

Register (registros del procesador)

Otros (Module, etc.)

Agregar un breakpoint para detener la ejecucién del programa, por ejemplo, al inicio de la funcién para
incrementar el timer.
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Variables y Funciones

1.

Observar (ver codigo assembler) como accede a las variables segun su tipo de almacenamiento
(estatico y automatico).

Repetir cambiando alguna variable por un puntero.

Agregar el modificador const a la variable t inicial y observar los cambios, por ejemplo
inspeccionando en el .map, o a través de los detalles dados por Memory Allocation.

Correr paso a paso para inspeccionar el stack antes, durante y después de la llamada a la funcion (ver
ventana Debug).

Deducir el uso del Stack y la convencién de llamadas a funcidn usada por el compilador.

Experimentar la ejecucion introduciendo breakpoints.

Para finalizar realizar los ultimos cambios a los archivos fuentes y crear un tag en el repositorio de
proyectos de nombre labl.

Parte 4) Conversion de tipos

El MSP430G2553 tiene un sensor de temperatura integrado que da el valor medido mediante un entero de 16
bits, que llamaremos datotemp. Segun los datos de calibracion de fabrica, la relacion entre la temperatura
medida (en °C) y esa indicacion esta dada por
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temperatura = datotemp * 0.413 - 277.75

Crear un proyecto nuevo vacio nombre labl-test-temp en la carpeta test/test-temp.

Implementar una funcién que realice ese calculo y un nuevo main.c como programa principal para
probar esa funcién. La funcidn recibira como entradas el valor de datotemp y devolvera el resultado en
un float. Para probar la funcién usar valores de datotemp entre 700 y 800.

Inspeccionar el codigo assembler generado y observar las conversiones de tipo que se realizan para
obtener el resultado.

Determinar cuantos ciclos de reloj demora en su ejecucion.

Proponer una funcioén alternativa que realice todas las operaciones entre enteros sin perder precision.
Repetir los pasos 3 y 4 con la funcién alternativa.

Para finalizar esta parte crear un tag en el repositorio de proyectos de nombre labl-test-temp.

Tenga en cuenta que el microcontrolador (MSP430G2553) no tiene unidad de punto flotante y tampoco
multiplicador hardware.

Referencias

Documentos técnicos
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MSP430G2553 LaunchPad™ Development Kit (MSP-EXP430G2ET) User's Guide
MSP430G2x53, MSP430G2x13 Mixed Signal Microcontroller datasheet (Rev. J)
MSP430x2xx Family User's Guide (Rev. J)
MSP430G2553 Device Erratasheet (Rev. 1)

MSP430 Optimizing C/C++ Compiler v18.1.0 LTS User's Guide

Enlaces

6.
7.
8.

Launchpad MSP-EXP430G2: http://www.ti.com/tool/msp-exp430g2et
MSP430G2553: http://www.ti.com/product/MSP430G2553
Code Composer Studio: http://www.ti.com/tool/ccstudio


http://www.ti.com/tool/ccstudio
http://www.ti.com/product/MSP430G2553
http://www.ti.com/tool/msp-exp430g2et
http://www.ti.com/lit/ug/slau132r/slau132r.pdf
http://www.ti.com/lit/pdf/slaz440
http://www.ti.com/lit/pdf/slau144
http://www.ti.com/lit/pdf/slas735
http://www.ti.com/lit/pdf/slau772

9. Code Composer Studio para MSP430 :http://www.ti.com/tool/ccstudio-msp
10. TI Clouds tools: http://dev.ti.com | Tl Resource Explorer: http:/dev.ti.com/tirex/



http://dev.ti.com/tirex/
http://dev.ti.com/
http://www.ti.com/tool/ccstudio-msp
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